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1PLAY (Ver. 2.1)-VI (Answer Key)

	Windows 10

Exercise

A.	 1. a	 2. a	 3. c	 4. d
B.	 1.	T	 2. T	 3. F	 4. T	 5. T
C.	 1.	Windows Media Player	 2. USB	 3. Picture 	 4. Jump list
D.	 1.	�Windows Media Player is an application software. It is used to play and organise both audio 

and video files on the computer.
	 2.	Pen drive, Memory card and DVD are three removable storage devices. 
	 3.	�a. Clipboard group: It has the Cut, Copy, and Paste commands.
		  b. Organize group: It has the Move to, Copy to, Delete, and Rename commands.
E.	 1.	Steps to safely remove a pen drive from your computer are:
	 	 Step 1	� Click on the arrow button present in the Notification Area on the Taskbar and 

click on the pen drive icon. 
	 	 Step 2	 Click on Eject option to safely remove the pen drive from the computer. 
	 2.	�Snap feature of Windows 10 is a feature that arranges the two windows side by side exactly 

to fill half of the screen. It is different from Sneak feature as the Sneak feature of Windows 
10 shows a preview of the windows that are open on the taskbar.

		�  Snap feature is useful when you have to compare two files. Sneak feature is useful when you 
have to restore different windows and search for a particular window.

F.	 Sneha can use a removable storage device like a pen drive to carry her data on official trips.
	 Follow the given steps to use a pendrive: 
	 Step 1	 Attach your pendrive to the USB port of your computer. 
	 Step 2	 Click on Open folder to view files when the AutoPlay dialog appears.
	 Step 3	� Select the files or folders which you want to copy,right-click, and choose Copy  

(or press Ctrl + C).
	 Step 4	� Browse the location in your computer where you want to copy the file or folder,  

right-click, and select Paste (or press Ctrl + V).

1.
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Periodic Assessment–1
(Based on chapters 1 & 2)

A.	 1.	Record Button is used to record your voice. 
	 2.	Stop button is used to stop the recording.
B.	 1.	�A jump list is a feature that allows you to view recent documents in a program that is pinned 

to the taskbar. 
	 2. Sneak feature of Windows 10 shows a preview of the windows that are open on the taskbar.

C.	 1. Organize group		 2. Share command

	 3. E-mail option		  4. Slide show option

	Formulas and Functions

Exercise

A.	 1.	a	 2. a	 3. b	 4. c	 5. c

B.	 1.	Functions 	 2. Equal to	 3. Square root	 4. Dollar ($)

C.	 1.	A cell reference is a cell address that can be used in a formula to denote a specific cell. 

	 2.	CONCATENATE () function joins together two or more different text strings.

	 3.	Date and Time functions are used to return date, month, day, year and time.

	 	 DAY(TODAY()) and MINUTE(time) are the types of Date and Time functions.

D.	 1.	The LEN function is used to return the length of the text string. 

	 	 For example, Input=LEN(“Excel”), it will return 5.

	 2.	Rules to enter a function are: 

	 	 (i)	 All Excel functions must begin with = sign. 

	 	 (ii)	 Function name must be a valid Excel name. 

	 	 (iii)	 Function must be followed by opening and closing parenthesis. 

	 	 (iv)	 Most of the Functions must contain an argument within it.
	 3.	�A formula is an expression which calculates the value of a cell. Formulas in Microsoft Excel 

begin with an equal sign (=). For example, 
	 	 = 10 + 20 / 5 + (5*4) 
	 	 = 20 + 60 * 10 
	 	� On other hand, functions are predefined formulas in Excel to perform both simple and complex 

calculations.

3.

	 Step 5	 Click the eject option from the Notification Area before unplugging.
In the lab

Do it yourself.

	Advanced Features of PowerPoint 2016

Exercise

A.	 1.	a	 2. d	 3. b	 4. a

B.	 1.	Insert video	 2. Text	 3. Slide	 4. Shapes

C.	 1.	F	 2. T	 3. T 	 4. T

D.	 1.	Paint, Excel and PowerPoint.

	 2.	�Transition determines how your presentation moves from one slide to the next whereas 
Animations help in giving a moving effect to text and other objects on a slide.

	 3.	�Animations can be used in PowerPoint to make a presentation more interesting. They give 
a moving effect a moving effect to the text and other objects on a slide.

E.	 1.	�To add sound to the presentation, follow these steps:

	 	 Step 1	 Click on Audio command on the Insert tab. A drop-down list appears.

	 	 Step 2	 Select the Audio from file option. The Insert Audio dialog box appears.

	 	 Step 3	� Navigate and select the audio file to be inserted and click on Insert button. This 
will insert a speaker icon on the slide.

	 	 Step 4	 Click on play button to listen to the audio.

	 2.	�Action buttons are used for navigating from one slide to another. We can also assign a 
particular task to do, when the viewer of the presentation clicks on an action button.

	 	 In PowerPoint, 12 types of action buttons are available.

	 3.	To add a video to the presentation, follow the given steps:

	 	 Step 1	 Click on Video option on the Insert tab to open Insert Video dialog box.

	 	 Step 2	 Navigate and select the video file to be inserted and click on Insert button.

	 		  This will insert the video along with the play control bar at the bottom of the clip.

	 	 Step 3	 Click on play button to preview the video.

F.	 I will suggest Rohan to find the Video command in the Insert tab.
In the lab

Do it yourself.

2.
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Periodic Assessment–1
(Based on chapters 1 & 2)

A.	 1.	Record Button is used to record your voice. 
	 2.	Stop button is used to stop the recording.
B.	 1.	�A jump list is a feature that allows you to view recent documents in a program that is pinned 

to the taskbar. 
	 2. Sneak feature of Windows 10 shows a preview of the windows that are open on the taskbar.

C.	 1. Organize group		 2. Share command

	 3. E-mail option		  4. Slide show option

	Formulas and Functions

Exercise

A.	 1.	a	 2. a	 3. b	 4. c	 5. c

B.	 1.	Functions 	 2. Equal to	 3. Square root	 4. Dollar ($)

C.	 1.	A cell reference is a cell address that can be used in a formula to denote a specific cell. 

	 2.	CONCATENATE () function joins together two or more different text strings.

	 3.	Date and Time functions are used to return date, month, day, year and time.

	 	 DAY(TODAY()) and MINUTE(time) are the types of Date and Time functions.

D.	 1.	The LEN function is used to return the length of the text string. 

	 	 For example, Input=LEN(“Excel”), it will return 5.

	 2.	Rules to enter a function are: 

	 	 (i)	 All Excel functions must begin with = sign. 

	 	 (ii)	 Function name must be a valid Excel name. 

	 	 (iii)	 Function must be followed by opening and closing parenthesis. 

	 	 (iv)	 Most of the Functions must contain an argument within it.
	 3.	�A formula is an expression which calculates the value of a cell. Formulas in Microsoft Excel 

begin with an equal sign (=). For example, 
	 	 = 10 + 20 / 5 + (5*4) 
	 	 = 20 + 60 * 10 
	 	� On other hand, functions are predefined formulas in Excel to perform both simple and complex 

calculations.

3.
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E.	 Aman can use the following date and time functions.
In the lab

Do it yourself.

	Introduction to GIMP

Exercise

A.	 1.	b	 2. c	 3. a	 4. d

B.	 1.	Workspace	 2. GIMP	 3. Layer effect	 4. Layers palette

	 5.	Patterns	 6. Fill with

C.	 1.	GIMP has user friendly interface.

	 2.	Template represents image types that are commonly useful.

	 3.	Menu bar, Toolbox and Layers palette.

D.	 1.	To save a file, follow the given steps:

	 	 Step 1	 Click on File menu.

	 	 Step 2	 Click on Save option.

	 	 Step 3	 Navigate the folder to save the file.

	 	 Step 4	 Given the name of the file in the Name: box.

	 	 Step 5	 Click on Save button.

	 2.	To open an image, follow the given steps:

	 	 Step 1	 Click on the File menu.

	 	 Step 2	 Click on the Open option.

	 	 Step 3	 Choose the image to be inserted.

	 	 Step 4	 Click on the Open button.

	 3.	The Create a New Image dialog box provides the following options:

	 	� Template: It represents image types that are commonly useful. The template sets values 
for the size, resolution, comments, etc.

	 	� Image Size: It specifies the width and height of the new document in pixels, centimeters, 
inches, points, millimetres, etc.

E.	 Here are some valid reasons why Nitin should consider:

	 	 ꔷ  User-friendly interface 

	 	 ꔷ  Image manipulation can be done quickly 

4.
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	 	 ꔷ  Layer effect preserves the original state of the image

	 	 ꔷ  Layer effect preserves the original state of the image 

	 �Support for a wide range of file formats, including GIF, JPEG, PNG, XPM, TIFF, TGA, MPEG, PS, 
PDF, PCX, BMP and more 

Do it yourself.

Hands-On

In the lab

Do it yourself.

Periodic Assessment–2
(Based on chapters 3 & 4)

A.	 1.	Cell reference

	 2. ROUND(number, number_of_digits)

	 3. Statistical functions

	 4. MIN(range)

	 5. LEN(text)

B.	

Image window

Ruler

Menu bar

Toolbox

Foreground/
Background 

color

Brushes/
Pattern/Fonts 
tabs

Layers
palette

Tools 
options

C.	 1.	Template			   2. Image Size

	 3. Portrait/Landscape button		  4. X and Y resolution
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Test Sheet–1
(Based on chapters 1 to 4)

Section A

A.	 1. (ii)	 2. (i)	 3. (i)	 4. (ii) 	 5. (i) 

	 6. (ii) 	 7. (iii) 	 8. (i)

B.	 1. Windows Media Player	 2. Text	 3. Square Root	

	 4. Layers palette	 5. Patterns

C.	 1. F	 2. F	 3. T	 4. T	

	 5. T	 6. F

Section B

A.	 1.	�Windows Media Player is application software. It is used to play and organise both audio and 
video files on the computer.

	 2.	Template represents image types that are commonly useful.

	 3.	�Transition determines how your presentation moves from one slide to the next whereas 
Animations help in giving a moving effect to text and other objects on a slide.

	 4.	A cell reference is a cell address that can be used in a formula to denote a specific cell.

	 5.	CONCATENATE () function joins together two or more different text strings.

B.	 1.	The LEN function is used to returns the length of the text string.
		  For example, Input=LEN(“Excel”), it will return 5.
	 2.	�Action buttons are used for navigating from one slide to another. We can also assign a 

particular task to do, when the viewer of the presentation clicks on an action button.
		  In PowerPoint, 12 types of action buttons are available.
	 3.	The Create a New Image dialog box provides the following options:
		�  Template: It represents image types that are commonly useful. The template sets values 

for the size, resolution, comments, etc.
		�  Image Size: It specifies the width and height of the new document in pixels, centimeters, 

inches, points, millimetres, etc.
	 4.	Pen drive, Memory card and DVD are three removable storage devices.
	 5.	To save a file, follow the given steps:
	 	 Step 1	 Click on File menu.

	 	 Step 2	 Click on Save option.

	 	 Step 3	 Navigate the folder to save the file.

	 	 Step 4	 Given the name of the file in the Name: box.

	 	 Step 5	 Click on Save button.

	Services on Internet

Exercise

A.	 1.	b	 2. a	 3. b	 4. a

B.	 1.	T	 2. T	 3. F	 4. T

C.	 1.	Carding	 2. Blogs	 3. Chat

D.	 1.	�Phreaking is a crime committed against telephone companies by using computers with the 
goal of making free distance calls or tapping phone lines.

	 2.	�A newsgroup focuses on a particular topic. The topic is of general interest of all the participants 
to the newsgroup.

	 3.	�Cloud storage is a service where the users are able to store and manage data on remote 
server in place of their local computer.

E.	 1.	�Steps to upload a file on Google Drive:

	 	 Step 1	� Visit www.google.com. Click on the Google App Launcher button at the  
top-right corner. Click on the Drive app. 

	 	 Step 2	� Enter your Gmail account‘s username and then click on Next button. Enter 
password and then click on Next button. 

	 	 Step 3	 Click on the New button. 

	 	 Step 4	 Click on File Upload to upload and store the file on the remote server. 

	 2. 	�Blogs are generally like a detailed explanation on a subject or sometimes also as a Diary of 
Events. It is a discussion platform where the readers of the blog can add their comments and 
suggestions. While blogging, you must keep in mind that your posts must not hurt feelings 
and reputation of others. Some of the popular websites which allow you to create blogs are 
Blogger, Wordpress, Tumblr, etc.

	 3.	�The process of protecting computer resources such as networks, devices, programs, and data 
from unauthorised access, damage, or attack is called cyber security.

F.	 He should use cloud storage service.
In the lab

Do it yourself.

5.
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	 	 Step 4	 Given the name of the file in the Name: box.

	 	 Step 5	 Click on Save button.

	Services on Internet

Exercise

A.	 1.	b	 2. a	 3. b	 4. a

B.	 1.	T	 2. T	 3. F	 4. T

C.	 1.	Carding	 2. Blogs	 3. Chat

D.	 1.	�Phreaking is a crime committed against telephone companies by using computers with the 
goal of making free distance calls or tapping phone lines.

	 2.	�A newsgroup focuses on a particular topic. The topic is of general interest of all the participants 
to the newsgroup.

	 3.	�Cloud storage is a service where the users are able to store and manage data on remote 
server in place of their local computer.

E.	 1.	�Steps to upload a file on Google Drive:

	 	 Step 1	� Visit www.google.com. Click on the Google App Launcher button at the  
top-right corner. Click on the Drive app. 

	 	 Step 2	� Enter your Gmail account‘s username and then click on Next button. Enter 
password and then click on Next button. 

	 	 Step 3	 Click on the New button. 

	 	 Step 4	 Click on File Upload to upload and store the file on the remote server. 

	 2. 	�Blogs are generally like a detailed explanation on a subject or sometimes also as a Diary of 
Events. It is a discussion platform where the readers of the blog can add their comments and 
suggestions. While blogging, you must keep in mind that your posts must not hurt feelings 
and reputation of others. Some of the popular websites which allow you to create blogs are 
Blogger, Wordpress, Tumblr, etc.

	 3.	�The process of protecting computer resources such as networks, devices, programs, and data 
from unauthorised access, damage, or attack is called cyber security.

F.	 He should use cloud storage service.
In the lab

Do it yourself.

5.
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	App Development

Exercise

A.	 1. a 	 2. a 	 3. a 	 4. b

B. 	 1. F 	 2. T 	 3. F 	 4. T 	 5. T

C.	 1. Hybrid 	 2. Mobile 	 3. Android 	 4. Gaming 	 5. Install

D.	 1.	�An app is a software program primarily developed for hand-held smart devices such as mobile 
and tablet.

	 2.	�Web apps are actually web applications which give a user experience similar to native apps. 
We need an extra app called browser to access these apps on our mobile device.

	 3.	Three components of Block Editor Window are:

	 	 a. Workspace: It arranges all the blocks for coding in the workspace. 

	 	 b. Trash: It is used for deleting blocks that are not required. 

	 	 c. Backpack: It stores the copy of all the blocks even when we exit App Inventor. 

E.	 1. a. �Gaming Apps- Today’s most popular category of mobile apps is gaming apps which shared 
more than 24% area of the app store. The most commonly used gaming apps are PUBG, 
Candy Crush Saga, and Angry Birds.

	 	 b. �Productivity apps, also known as business apps used by businessmen to perform several 
complex tasks. The most commonly used productive apps are Google Calendar, Evernote 
and Dropbox.

	 	 c. �Entertainment apps are developed to entertain the people. The most commonly used 
entertainment apps are Netflix, Plus Hotstar and YouTube.

	 2.	To change the display name, follow the given steps:

	 	 Step 1	 Click on the button in the View pane.

	 	 Step 2	� Select the Text option in Properties pane and change 'Text for Button1' to the 
text you want to display on the button. 

	 3.	�The difference between web app and website is that a web app can be a small part of a 
website which provides a particular functionality. On the other hand, a website can contain 
many web apps.

	 4.	�Educational apps provide a platform for children to learn from anywhere and anytime. These 
apps use advance methodologies and new concepts to make the learning easier. The most  
commonly used educational apps are Khan Academy, Vedantu, and Grammar EN.

6. F.	 1.	Gaming 

	 2.	Music Player
In the lab

Do it yourself.

	Introduction to HTML5 and CSS3

Exercise

A.	 1.	a	 2. b	 3. a	 4. b 

B.	 1.	Markup	 2. Head	 3. Block	 4. Empty	 5. Nesting

C.	 1.	�HTML stands for Hypertext Markup Language. It is a markup language that describes the 
structure of the web page.

	 2.	The tags that include both opening and closing tags are called Container Tags.

	 3.	CSS handles and describes how a HTML web page will be presented on a web browser. 

	 4.	�The <Head> tag defines header area of your web page. The information given in <Head > 
tag tells the computer that this information is not to be shown on the web page.

	 5.	�In external stylesheet, the CSS styles are written in a separate file which is saved with .css 
extension. You need to include a reference to the external style sheet file within the <LINK> 
element inside the <HEAD> element. Syntax to include the reference of external stylesheet is: 

	 	 <head>

	 	 <link rel="stylesheet" type="text/css" href="name of style sheet"> 

	 	 </head>

D.	 1.	The rules for writing HTML tags are:

	 	 ꔷ  Container tags should always be closed properly.

	 	 ꔷ  Values given to the attributes should be enclosed within the double quotes.

	 	 ꔷ  Tag name should not contain spaces.

	 	 ꔷ  There should be no spaces between < and > in a tag.

	 	 ꔷ  Tags must be nested correctly.

	 2.	�HTML editors are software which are used to write and edit HTML codes. There are mainly 
two types of HTML editors, WYSIWYG editor and Text Editor. The most commonly used HTML 
editors are Notepad and WordPad.

7.
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F.	 1.	Gaming 

	 2.	Music Player
In the lab

Do it yourself.

	Introduction to HTML5 and CSS3

Exercise

A.	 1.	a	 2. b	 3. a	 4. b 

B.	 1.	Markup	 2. Head	 3. Block	 4. Empty	 5. Nesting

C.	 1.	�HTML stands for Hypertext Markup Language. It is a markup language that describes the 
structure of the web page.

	 2.	The tags that include both opening and closing tags are called Container Tags.

	 3.	CSS handles and describes how a HTML web page will be presented on a web browser. 

	 4.	�The <Head> tag defines header area of your web page. The information given in <Head > 
tag tells the computer that this information is not to be shown on the web page.

	 5.	�In external stylesheet, the CSS styles are written in a separate file which is saved with .css 
extension. You need to include a reference to the external style sheet file within the <LINK> 
element inside the <HEAD> element. Syntax to include the reference of external stylesheet is: 

	 	 <head>

	 	 <link rel="stylesheet" type="text/css" href="name of style sheet"> 

	 	 </head>

D.	 1.	The rules for writing HTML tags are:

	 	 ꔷ  Container tags should always be closed properly.

	 	 ꔷ  Values given to the attributes should be enclosed within the double quotes.

	 	 ꔷ  Tag name should not contain spaces.

	 	 ꔷ  There should be no spaces between < and > in a tag.

	 	 ꔷ  Tags must be nested correctly.

	 2.	�HTML editors are software which are used to write and edit HTML codes. There are mainly 
two types of HTML editors, WYSIWYG editor and Text Editor. The most commonly used HTML 
editors are Notepad and WordPad.

7.
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	 3.	�An inline style is used to apply a unique style for a single element. The style attribute an 
element allows you to create and apply a style on the element. Syntax to create an inline 
style is:

	 	 <element style = "property1:value1; property2:value2; … ….">

E.	 1.	Ajit can use heading tags <H1> to <H6>.

	 2.	Anjali can use <TITLE> tag.

F.	
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In the lab

Do it yourself.

Periodic Assessment–3
(Based on chapters 5 to 7)

A.	 1.	�Blogs are generally like a detailed explanation on a subject or sometimes also as a diary of 
events. 

	 2.	�Cloud storage is a service where the users are able to store and manage data on remote 
server in place of their local computer. 

	 3.	�The process of protecting computer resources such as networks, devices, programs, and data 
from unauthorised access, damage, or attack is called cyber security. 

	 4.	�Hacking is the unauthorised access to computer system for the purpose of destroying the 
system or stealing important information from the system. 

B.	 1.	Google Play Store	 2. iOS 	 3. Hybrid app 	 4. Gaming app
	 5. Educational app		 6. Social networking apps 
C.	 TITLE	 </HEAD>	 </HTML>

	Algorithmic Intelligence

Exercise

A.	 1.	a	 2. b	 3. d	 4. c

B.	 1. F	 2. F	 3. T	 4. F

C.	 1.	Creative 	 2. Flowchart	 3. Logical	 4. Mind map

	 5. Parallelogram	 6. Two

D.	 1.	�The construction of the Algorithm is the stage that requires creative thinking and finding the 
best possible combination of steps to get the result. 

	 2.	Emily can use flowcharts. 

	 3.	�Diamond symbol indicates a question or branch in the process flow. It is used when there 
are 2 options (Yes/No). 

E.	 1.	�A Mind Map is a also a problem-solving technique that allows us to organise ideas, thoughts, 
or concepts and their relationship graphically. 

	 2.	�A flowchart is a type of graphical diagram that represents an algorithm. Flowcharts are used 
in analysing, designing, documenting, or managing a process or program in various fields.

	 3.	Basic rules while drawing a flowchart: 

	 	 ꔷ  Maintain the direction of the flow from left to right or top to bottom. 

	 	 ꔷ  Only one flow line should come out from a process box. 

	 	 ꔷ � Only one flow line should enter a decision box, but two flow lines should leave the decision 
box. 

	 	 ꔷ  Ensure that the flowchart has a logical start and end. 

F.	 1.	Nisha is following the Algorithmic strategy of problem solving.

	 2.	Anshu should use the arrow symbol.
In the lab

Do it yourself.

	Introduction to Programming Python

Exercise

A.	 1. b	 2. a	 3. c	 4. c	 5. c 

B.	 1. T	 2. T	 3. F	 4. T

8.

9.
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	Algorithmic Intelligence

Exercise

A.	 1.	a	 2. b	 3. d	 4. c

B.	 1. F	 2. F	 3. T	 4. F

C.	 1.	Creative 	 2. Flowchart	 3. Logical	 4. Mind map

	 5. Parallelogram	 6. Two

D.	 1.	�The construction of the Algorithm is the stage that requires creative thinking and finding the 
best possible combination of steps to get the result. 

	 2.	Emily can use flowcharts. 

	 3.	�Diamond symbol indicates a question or branch in the process flow. It is used when there 
are 2 options (Yes/No). 

E.	 1.	�A Mind Map is a also a problem-solving technique that allows us to organise ideas, thoughts, 
or concepts and their relationship graphically. 

	 2.	�A flowchart is a type of graphical diagram that represents an algorithm. Flowcharts are used 
in analysing, designing, documenting, or managing a process or program in various fields.

	 3.	Basic rules while drawing a flowchart: 

	 	 ꔷ  Maintain the direction of the flow from left to right or top to bottom. 

	 	 ꔷ  Only one flow line should come out from a process box. 

	 	 ꔷ � Only one flow line should enter a decision box, but two flow lines should leave the decision 
box. 

	 	 ꔷ  Ensure that the flowchart has a logical start and end. 

F.	 1.	Nisha is following the Algorithmic strategy of problem solving.

	 2.	Anshu should use the arrow symbol.
In the lab

Do it yourself.

	Introduction to Programming Python

Exercise

A.	 1. b	 2. a	 3. c	 4. c	 5. c 

B.	 1. T	 2. T	 3. F	 4. T

8.

9.
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C.	 1. Guido van Rossum 	 2. Assignment		  3. String 

	 4. Input() 		  5. False 

D.	 1. �Variables are memory reference points where we store values which can be accessed or 
changed later. 

	 2. A data type specifies the type of value a variable can contains. 

	 3. �A low-level language is a programming language that is machine dependent. A program 
written in machine dependent language runs only on one particular type of computer. 

E. 	 1. Following are the relational operators provided by Python: 

	 	 == Equal

	 	 != Not equal 

	 	 > Greater than 

	 	 < Less than 

	 	 >= Greater than or equal to 

	 	 <= Less than or equal to 

	 	� For example, == operator: It checks if the values of two operands are equal or not. If yes, 
then the condition becomes true. 

	 2.	�Comments in Python can be used to explain parts of the code. It can also be used to hide the 
code as well. Comments enable us to understand the way a program works. In python, any 
statement starting with # symbol is known as a comment. There are two types of comments 
in python:

	 	 a. �Single Line Comment: In case, a user wants to specify a single line comment, then comment 
must start with the symbol #. 

	 	 b. �Multiple-line Comment: Python does not have a syntax for multiline comments. To add a 
multiple line comment, you could insert a # for each line. 

	 3. �High-level language is a programming language that enables a programmer to write programs 
that are machine independent.

	 	� In third generation languages (3GL), the programmer writes a series of English like words 
that tell the computer what to accomplish and how to do. Examples of 3GL are C, C++ and 
Java. 

	 	� The fourth generation languages also use English like statements. They specify what the 
program should accomplish without explaining how. A 4GL is fast and requires less time and 
effort on the part of the programmer. Examples of 4GL are SQL, Perl, Python, etc. 

F.	 1.	She should use Run Module option in the Run tab of the Menu bar. 

	 2.	a.  2.0 	 b.  12
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In the lab

Do it yourself.

	Introduction to AI

Exercise

A.	 1. d	 2. b	 3. b 

B.	 1. Interpersonal	 2. Intelligence	 3. Howard Gardner

C.	 1. T	 2. F	 3. T

D.	 1. �Bodily-Kinesthetic Intelligence is being good at dancing and sports along with love creating 
things with their hands, tends to remember by doing, rather than hearing and seeing, and 
excellent hand-eye and physical coordination, flexible in different body movements and 
performing actions.

	 2. �AI is the branch of computer science that focuses on developing machines which can think 
and work like human beings.

E. 	 1. Four uses of AI are:

	 	 a. It can automate the repetitive complex tasks. 

	 	 b. It can predict movies/TV shows/songs/products as per your choice with most accuracy. 

	 	 c. It can diagnose diseases more effectively than doctor. 

	 	 d. It can mimic human voice and understands context. 

	 2. �Intelligence refers to the ability to think, to learn from previous experience, to solve complex 
problems and to adapt new things and environment.

	 	 Three types of intelligence are:

	 	 a. Naturalistic Intelligence 

	 	 b. Interpersonal Intelligence 

	 	 c. Musical Intelligence 
	 3.	a. 

Interpersonal Intelligence Intrapersonal Intelligence 

	 i.	� Good at communicating ideas and thoughts 	 i.	� Can recognise their strengths and weaknesses 

	ii.	� Good at non-verbal communication 
	ii.	�� Aware of their own emotional state and 

feelings and know how they can motivate 
themselves 

	iii.	� Have a different perspective on everything 	iii.	� Enjoy analysing theories and ideas 

10.
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		  b. Existential Intelligence Musical Intelligence 

	 i.	� Look at things from different point of view. 	 i.	� Love singing and playing musical instruments 

	ii.	� Make connections between what is being 
learned and the world outside. 

	ii.	�� Good at thinking in patterns, rhythms and 
sounds 

	iii.	� Have a deep and comprehensive understanding 
not just of the universe, but of the self. 	iii.	� Recognise musical patterns and tones easily 

F.	 1. Naturalistic Intelligence	 2. Interpersonal Intelligence

G.	 1. 64	 2. 141	 3. Plant. Spatial Intelligence is being used here.

H.	 Visual-Spatial Intelligence is being used here.

_____________
In the lab

Do it yourself.

Periodic Assessment–4
(Based on chapters 8 to 10)

A.	 1. �Existential Intelligent people look at things from different point of view, they make connections 
between what is being learned and the world outside and they have a deep and comprehensive 
understanding not just of the universe, but of the self. 

	 2. �Naturalistic Intelligent people are nature lovers, they love exploring the environment and 
learning about other species and enjoy camping, gardening, hiking and exploring outdoors. 

B.	 l = int(input('Enter the length of a Rectangle: '))

	 b = int(input('Enter the breadth of a Rectangle: '))

	 area = l * b

	 print("Area of a Rectangle is: ",area)

C.	 1.	Error: In line 1, comma after variable q

	 2.	Error: In line 3, var3 name and in line 4, plus sign after var1.
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Test Sheet–2
(Based on chapters 5 to 10)

Section A
A.	 1. (ii)	 2. (i) 	 3. (ii)	 4. (iii)	 5. (iv)
	 6. (ii) 	 7. (ii)	 8. (i)	 9. (i)	 10. (i)
B.	 1.	Interpersonal	 2. Assignment	 3. Block	 4. Install
	 5.	Carding	 6. False	 7. Missing
C.	 1. T	 2. T	 3. T	 4. T	 5. F

Section B

A.	 1.	�Variables are memory reference points where we store values which can be accessed or 
changed later.

	 2.	�A low-level language is a programming language that is machine dependent. A program 
written in machine dependent language runs only on one particular type of computer.

	 3.	The tags that include both opening and closing tags are called Container Tags.

	 4.	Web apps are actually web applications which give a user experience similar to native apps.

	 5.	�Hacking is the unauthorised access to computer system for the purpose of destroying the 
system or stealing important information from the system.

B.	 1.	�Steps to upload a file on Google Drive:

	 	 Step 1	 �Visit www.google.com. 

	 	 Step 2	� Click on the Google App Launcher button at the top-right corner. A list of Google 
apps appears. 

		  Step 3	 Click on the Drive app. The Google's Sign in page appears. 

		  Step 4	 Enter your Gmail account‘s username and then click on Next button. 

	 	 Step 5	� Enter password and then click on Next button. This will open your Google Drive 
web page. 

		  Step 6	 Click on the New button. 

	 	 Step 7	� Click on Upload Folders to upload and store the entire folder on the remote 
server. 

	 2.	 (i)	� Gaming Apps- Today’s most popular category of mobile apps is gaming apps which 
share more than 24% area of the app store. The most commonly used gaming apps are 
PUBG, Candy Crush Saga, and Angry Birds.
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		  (ii)	� Productivity apps- These apps also known as business apps used by businessmen to 
perform several complex tasks. The most commonly used productive apps are Google 
Calendar, Evernote and Dropbox.

		  (iii)	� Entertainment apps- These apps are developed to entertain the people. The most 
commonly used entertainment apps are Netflix, Disney Plus Hotstar and YouTube.

	 3.	�An inline style is used to apply a unique style for a single element. The style attribute an 
element allows you to create and apply a style on the element. Syntax to create an inline 
style is: 

		  <element style = "property1:value1; property2:value2; … ….">

	 4.	�A flowchart is a type of graphical diagram that represents an algorithm. Flowcharts are used 
in analysing, designing, documenting, or managing a process or program in various fields.

	 5.	�Comments in Python can be used to explain parts of the code. It can also be used to hide the 
code as well. Comments enable us to understand the way a program works. In python, any 
statement starting with # symbol is known as a comment. There are two types of comments 
in Python:

		  1. �Single Line Comment: In case, a user wants to specify a single line comment, then comment 
must start with the symbol #. 

		  2. �Multiple-line Comment: Python does not have a syntax for multiline comments. To add a 
multiple line comment, you could insert a # for each line.

	 6.	�Linguistic Intelligent people are good at using words, can remember written and spoken 
information, love reading and writing, are good debaters, can explain things well and use 
humour while telling stories.


